
Lab Procedures: Texas Instruments Low-Power Wireless Speedway Workshop 

 

 
 
 
 
 
 
 
 
 

Avnet / Texas Instruments  
Low-Power RF Workshop 

 
 

Lab Procedures 
 
 

Lab 1 - Exploring TI‟s eZ430 Chronos kit:  
wireless aspects of provided CC430 Projects 
 
Lab 2 - Chronos2Chronos Communication,  
SmartRF Studio and RSSI Power Meter 

 
 
 
 
 
 
 
 

 

by Peter Fenn,  
Avnet Global Technical Marketing  
 
 
 
 

Version 1.3



Lab Procedures: Texas Instruments Low-Power Wireless Speedway Workshop 
 

 Page 2 of 20  
 

 
Revision History 

Version Description Date 

1.0 Initial release 7/13/2011 

1.1 Updates based on initial feedback from Denver 7/26/2011 

1.2 Changes to Lab1 procedure after Denver workshop 8/03/2011 

1.3 Changes to Lab1 procedure after Wisconsin workshop 8/11/2011 

 
 

Table of Contents 

Table of Contents .......................................................................................................................................... 2 
Table of Figures ............................................................................................................................................ 2 
Overview ....................................................................................................................................................... 3 
Objectives...................................................................................................................................................... 4 
Getting Started - What you need .................................................................................................................. 4 
Lab1: Exploring Chronos Functionality & Features ...................................................................................... 5 
Lab1: SimpliciTI transmission of Accelerometer data ................................................................................... 6 
Lab1: BlueRobin RF reception of Heart-Rate & Speed  (displays on both PC and Chronos) ...................... 7 
Lab1: RFBSL Wireless Firmware Update ..................................................................................................... 8 
Lab1: RFBSL Wireless Firmware Update ................................................................................................... 10 
Lab 2A: Chronos 2 Chronos Communication ............................................................................................. 11 
Lab 2A: Chronos disassembly and Lab procedure: .................................................................................... 11 
Lab 2A: Hardware and Project Setup ......................................................................................................... 12 
Lab 2B: SmartRF Studio + Chronos ........................................................................................................... 15 
Smart RF Studio 7: Configure Register View .............................................................................................. 16 
Lab 2C : Chronos RSSI Meter .................................................................................................................... 18 
Labs: Part 2 Conclusions…......................................................................................................................... 19 
Appendix: Re-flash of Chronos back to default “Sportswatch” application ................................................. 20 
Getting Help and Support............................................................................................................................ 20 
 
 

Table of Figures 

Figure 1 - Hardware Platform ........................................................................................................................ 3 
Figure 2 - eZ430-Chronos Feature Overview and Menu Structure .............................................................. 5 
Figure 3 - eZ430-Chronos Control Center with Acceleration Data ............................................................... 6 
Figure 4 - eZ430-Chronos Control Center Heart Rate Simulator ................................................................. 7 
Figure 5 - Detail of Chronos control buttons and LCD .................................................................................. 7 
Figure 6 - eZ430-Chronos Control Center Wireless Update ......................................................................... 8 
Figure 7 - eZ430-Chronos Data Logger Feature Overview and Menu Structure ......................................... 9 
Figure 8 - Example data log read-back from Chronos ................................................................................ 10 
Figure 9 - Chronos Disassembly ................................................................................................................. 11 
Figure 10 - Chronos attached to Emulator and USB Extension ................................................................. 12 
Figure 11 - BM Innovations Firmware Updater Tool re-programming Chronos ......................................... 20 
 
  

file:///C:/Documents%20and%20Settings/016424/My%20Documents/Avnet%20GTM%20Projects/TI/TI-Speedway-LPRF/Handouts/TI%20LPRF%20Workshop%20Labs%20Procedure.docx%23_Toc298340078
file:///C:/Documents%20and%20Settings/016424/My%20Documents/Avnet%20GTM%20Projects/TI/TI-Speedway-LPRF/Handouts/TI%20LPRF%20Workshop%20Labs%20Procedure.docx%23_Toc298340079


Lab Procedures: Texas Instruments Low-Power Wireless Speedway Workshop 
 

 Page 3 of 20  
 

Overview 

These labs commence with a quick overview of the eZ430 Chronos Eval Kit, it‟s CC430 (microcontroller + 
RF transceiver), the software tools and RF Networking protocols utilized (SimpliciTI, BlueRobin, RFBSL)  

Lab1 steps users through a hands-on exploration of features and operation of eZ430 Chronos kit with 
focus specifically on the wireless communication aspects of the provided Open Source Projects 

Lab 2A: Firmware re-compile for Chronos2Chronos (peer to peer) communication 

Lab 2B: Use of SmartRF Studio to re-configure CC430 RF settings 

Lab 2C: Implement a simple RSSI power-meter application on Chronos  

Lab 3  : Instructor led demos  
a) Chronos as an accelerometer-based remote-control directing the motor-control drive- and steering of a 
mobile Stellaris (ARM Cortex-M3 EvalBot board. 

b) Android based Bluetooth messaging to a Fossil MetaWatch 
 

)

 

 

Figure 1 - Hardware Platform 



Lab Procedures: Texas Instruments Low-Power Wireless Speedway Workshop 
 

 Page 4 of 20  
 

Objectives 

Gain practical hands-on experience working with devices from TI‟s LPRF portfolio 
ie. CC430F6137 (on Chronos), CC1111 (on RF Gateway), CC1101 (on EvalBot) 
 
Exposure to a subset of the available TI tools:  
Code Composer Studio (CCS4), eZ430-Chronos, SmartRF Studio7 as well as 5 example applications:  
(Chronos Sports Watch, Chronos DataLogger, Chronos2Chronos, Chronos RSSI and Chronos Drive) 
 

Getting Started - What you need 

Hardware: 

a) Laptop Computer (Attendee responsibility!): running MS Windows XP or Windows-7  
(ideally with 2 USB ports available) 

b) eZ430-Chronos Development Tool Kit (Avnet will provide), part# EZ430-CHRONOS-915 
(includes USB-based Access Point and USB-based Programmer/Debugger) 

Software: 

c) eZ430-Chronos Software Package  
Download latest version from the provided link and install on Laptop PC 
(Do not install from the CD that came with the kit!) :  
Windows (SLAC341)  
Note: It is recommended Windows display DPI configuration is for “normal” (100%) font-size. 

d) Compiler/Debugger IDE (install on laptop PC):  
CCS4 (Note: must be the Platinum, node-locked version, but only support for MSP430 family 
needs to be loaded. Activate the 30-day license by going to:  
http://tiexpressdsp.com/wiki/index.php?title=Activating_CCS 
then follow the step-by-step instructions on that page… 

e) Lab 2 Chronos2Chronos and RSSI Project Files  
(Accessed from Customer Pre-Work email /or FAE access to Avnet Sharepoint,  
also available at workshop on USB Thumb-drive) 
Unzip to C:\TEMP folder for now 

f) Firmware Update tool (optional, standalone tool from BMI for adding rfBSL updates) 
eZ430-Chronos Watch Firmware Update Tool  

g) TI‟s Smart RF Studio 7 Software Tool (install on laptop PC) 
SmartRF Studio 7 v1.5.0   

Documentation (only for reference as needed): 

o eZ430-Chronos User Guide (SLAU292):  
Technical details and instructions for Chronos (is included in eZ430-Chronos software install) 

o CC430 User Guide: Technical user manual for CC430 

o CC430F613x Datasheet: Electrical specs for CC430F613x  

 

http://www.ti.com/lit/zip/slac341
http://software-dl.ti.com/dsps/forms/self_cert_export.html?prod_no=setup_CCS_4_Platinum.zip&ref_url=http://software-dl.ti.com/dsps/dsps_public_sw/sdo_ccstudio/CCSv4/latest/
http://tiexpressdsp.com/wiki/index.php?title=Activating_CCS
http://myavnet/sites/EMTexasInst/default.aspx?RootFolder=%2fsites%2fEMTexasInst%2fShared%20Documents%2fQ3-Q4%20Workshops%2fRF%20Chronos%2fPresentation%20and%20labs&View
http://www.bm-innovations.com/index.php/ez430-chronos.html?file=tl_files/bm_innovations/downloads/eZ430-Chronos%20Watch%20Firmware%20Update%20Tool.zip
http://www.ti.com/litv/zip/swrc176i
http://www.ti.com/lit/pdf/slau292
http://www.ti.com/lit/pdf/slau259
http://www.ti.com/lit/gpn/cc430f6137
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Lab1: Exploring Chronos Functionality & Features 

 
Lab 1 - Exploring TI‟s eZ430 Chronos kit:  Wireless aspects of the provided CC430 Projects 
 
Caution!  The RF Access Points are factory-set to transmit on the same frequency.  
Lab1 requires careful management of workshop attendees to ensure only one Access Point and  
Chronos is enabled / transmitting at a given time, especially when doing the following:  
- synchronizing (eg. setting Date & Time, Temp & Altitude calibration,etc) Chronos to the Laptop, and  
- when executing RFBSL over the air firmware updates 
 
Symptoms to look-out for of more than one Chronos or Access Point transmitting are: 
- jerky/slowed updates of the displayed XYZ accelerometer readings 
- failure to set the time from laptop, failure of RFBSL over the air firmware updates 
(This not an issue for Lab2 where communication is peer to peer with different frequency channels 
allocated to pairs of workshop attendees). 
 
1) Test-drive the default “Chronos Sports Watch” App as shipped in standalone mode, using „*‟ and „#‟ 

buttons to navigate the 2 sets of menus. (Instruction card inside the box your eZ430 Chronos arrived 
in as well as Figure 2 below provide guidance on this…) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 2 - eZ430-Chronos Feature Overview and Menu Structure 
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Lab1: SimpliciTI transmission of Accelerometer data 
 
During the course of these labs hardware drivers will be installed for both the provided USB “dongles”: 
a) eZ430 Chronos RF Access Point 
b) eZ430 Debug Interface 
*The USB drivers are included in the eZ430-Chronos installer package. Windows USB driver installation 
is described in detail in Appendix B (pages 96 to 101) of the eZ430 Chronos User Guide).  
 
1) Install the supplied eZ430-Chronos RF Access Point dongle into one of your laptop USB ports. If this 

is the first time it is being inserted, the Device Driver Installation Wizard window will appear on the 
screen. Complete this install wizard as detailed in Appendix B of the eZ430 Chronos User Guide. 

 
2) On Laptop: launch the Chronos Control Center (Programs Texas Instruments  ez430-Chronos), 

select SimpliciTI Acc tab, then click “Start Access Point”  
 

3) On Chronos: Use „#‟ button to get to "ACC" mode (lower line of Chronos LCD)  
Follow direction from class Instructor as to when you can activate data transmission using the 
“DOWN” button   

 
4) On Laptop (one at a time): Live XYZ accelerometer data will be displayed with smooth updates of 

XYZ data as Chronos is moved around. 
 

5) On Laptop (now with multiple units transmitting): Live XYZ accelerometer screen updates are now 
very intermittent as conflicts occur between the transmissions from multiple Chronos units 
 

 

Figure 3 - eZ430-Chronos Control Center with Acceleration Data 

 

http://focus.ti.com/lit/ug/slau292c/slau292c.pdf
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Lab1: BlueRobin RF reception of Heart-Rate & Speed  
(displays on both PC and Chronos) 

  
6) On Laptop: in Chronos Control Center select “BlueRobin Heart Rate Sim”  tab, check “Sweep 

Heart Rate“, ”Sweep Speed”  and “km/h”   
then click “Start Transmitter”  
 

7) On Chronos: Use the “*” button to advance to Heartrate (“♥“) mode,  
then press the “Up" button to enable data reception  

 
8) On Chronos: Simulated Heartrate is displayed on upper line of LCD 

 
9) On Chronos: press “*” once more to display Speed (mph or km/h) 

 
10) When finished, use the “*” button to cycle through to Heartrate (“♥“) mode again then press “Up" 

button once more to disable Blue Robin reception 
 

 

Figure 4 - eZ430-Chronos Control Center Heart Rate Simulator 

 
 

    
 
 
 
 
 
 

Figure 5 - Detail of Chronos control buttons and LCD 
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Lab1: RFBSL Wireless Firmware Update 
(downloading the Datalogger application) 
 
11) On Laptop: In Chronos Control Center select Wireless Update, then Browse to  

 C:\Program Files\Texas Instruments\eZ430-Chronos\Recovery\Chronos Watch\Applications  
Select  Recovery_ez430_chronos_datalogger_915MHz.txt 
On Laptop: Click Update Chronos Watch 

 
Attention! - Multiple Chronos updates transmitted at the same time will likely result in update errors!  
In the interest of completing the labs in the allocated time, steps 12 through 29 should be done  
only by the instructor  ! 
ie. The remainder of Lab1 is performed by the Instructor only! Workshop attendees follow the 
procedure in their notes but do not re-flash their Chronos units to the Datalogger application. 
 
12) Instructor: Press "#" button until "rFbSL" is displayed 

Instructor: Press Down button: “ConF” is displayed (/may be absent if older Chronos firmware)  
Instructor: Press Down button again to confirm and commence the firmware update… 

 
13) On Chronos: “rAN” will display briefly, followed by an incrementing nn% progress indicator on top line 

of LCD, “dLog” then displays on lower line after completion (may need button press to wake display). 
 

14) On Laptop: Close the Chronos Control Center app. 
 

15) On Laptop: Launch the Chronos DataLogger application  
(Start  Programs  Texas Instruments  eZ430-Chronos  Chronos DataLogger) 
The SimpliciTI Sync tab facilitates setting time/date and calibration of sensors as well as readback of 
the logged data from Chronos datalogger memory. 

 

 

Figure 6 - eZ430-Chronos Control Center Wireless Update 
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Lab1: Pairing Chronos and Laptop PC: 
 

16) On Laptop PC: Activate pairing by clicking on "Start Access Point“. 
 

17) On Chronos: Select "SYnC“ by pressing the "#" button 
 

18) On Chronos: Initiate pairing by pressing the "DOWN" button 
(to activate the selected SYnC mode) 

After a short time, the link is established (the ))) symbol should flash continuously…) 

 

 

Figure 7 - eZ430-Chronos Data Logger Feature Overview and Menu Structure 

 
19) Enter data to calibrate sensors:  

- click-on Imperial Units 
- for Data Log Mode check Temperature and Altitude  
- enter Temperature and Altitude calibration vales (approximate is ok) 
- set datalog interval to 1 sec. 

 
20) Set date and time values using the provided drop-down lists 
 
21) Click "Set Watch" to transfer data to watch, the watch shows “donE" 

 
22) Press the "DOWN" button on watch to end the SYNC connection 

 
23) Press the "#" button 3 times to advance from SYNC mode to DLOG mode   

 
24) Press the DOWN button to commence datalog capture, a (R) symbol should appear on Chronos 

screen indicating that it is recording, allow data capture to continue for approximately 15 seconds 
then again press the DOWN button to end the datalog. 

 
25) On Chronos: Press "#" button once to return to Select "SYnC“ mode 
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26) On Chronos: Again pair with Laptop PC by pressing the "DOWN" button,  

(the ))) symbol should flash continuously…) 

 
27) Specify (Save data to) file name (DataLog1.csv) and location to store the log file then  

Click on "Download" to start data transfer 
 

28) On Chronos: push the "DOWN" button to stop connection when the transfer has finished. 
 

29) On PC: Open the saved file (DataLog1.csv) in a text editor or Excel.  
 

Log file is stored in CSV format. Its content appears as one line per log, each line starts with date, time, 
heart rate, temperature, and altitude. Parameters which were not logged are set to zero (according to 
what you set in the eZ430-Chronos Data Logger PC console software). 

 

Figure 8 - Example data log read-back from Chronos 

Lab1: RFBSL Wireless Firmware Update  
(optional, not required! For eg. restoring default Sportswatch application without proceeding to Lab2) 

30) Optional: On Laptop: From Chronos DataLogger (OR Chronos Control Center) application  
select the Wireless Update tab, then Browse to: 
C:\Program Files\Texas Instruments\eZ430-Chronos\Recovery\Chronos Watch\Applications  
Select  Recovery_ez430_chronos_915MHz.txt    then click Update Chronos Watch 
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Lab 2A: Chronos 2 Chronos Communication 
 
Lab 2A - Firmware re-compile for Chronos2Chronos communication 
Lab 2B - Use of SmartRF Studio to re-configure CC430 RF settings 
Lab 2C - RSSI Power Meter  
 
Objective: 

• Working in pairs, set your assigned RF channel by editing source code with CCS 
• Compile & Download to Chronos  
• Link & find your partner…  

Notes:  
ISM band is used, channel spacing is 200kHz, for our purpose users are 5 chan apart (1MHz spacing): 

• USA 915 MHz (902–928 MHz) 
• EUR 868 MHz (Europe version of Lab2 allocates channels in the range 870–899 MHz  

(permissable only for test purposes)     
 
                                             
 
 
 
 
 
 
 
 
 
 

Lab 2A: Chronos disassembly and Lab procedure:  

1) Press down screwdriver firmly when unscrewing to prevent stripping!  
 

2) Pry against edge of the eZ-connector to lift the PCB out 
 

3) The battery should not be removed from the battery holder for these labs !!!   
(On TI‟s advice we can disregard the warning label for the relatively short duration of this workshop) 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
* Optional Battery Replacement Procedure (after workshop):  
If interested in replacing the battery, view the provided video before attempting this… 
Chronos Disassembly & Reassembly Video: 
http://www.youtube.com/watch?v=WDL3awjhLpw 

Figure 9 - Chronos Disassembly 

http://www.youtube.com/watch?v=WDL3awjhLpw
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Lab 2A: Hardware and Project Setup 
 

4) Connect the unpackaged Chronos module to the eZ430 USB Emulator. Laptops with vertically 
orientated USB connectors will require a short USB extension cable  
ie. Standard Male (type-A) USB Plug to Female (type-A) USB Socket 
(- alternatively the laptop can be raised by inserting a book below it…) 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 

5) Now plug the eZ430 USB Emulator into the USB port of Laptop PC. 
 

6) On the Laptop, in File Explorer: Copy and unzip the provided files: 
Lab2AB_Chronos2Chronos.zip and  
Lab2C_RSSI_PowerMeter.zip   to your C:\TEMP folder 
 

7) Open CCS4  
 

8) File > Switch Workspace > C:\TI_workshop\Workspace  [click ok] 
 

9) Close the Welcome panel, Close the Grace panel 
 

10) Import Project 
 

11) Project > Import Existing CCS/CCE Eclipse Project 
 

12) Select C:\TEMP\Lab2_Chronos2Chronos project  
(ensure “Copy Projects into Workspace” checkbox is checked)  
 

13) Click Finish to import…  
 

14) Right Click on project name > “Set as Active Project”, next 
 

15) Select „Active Build Config‟: 915MHz - Unrestricted CCS Platinum ( USA )  
 
 

 

Figure 10 - Chronos attached to Emulator and USB Extension 
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16) Open smartrf_CC430.h in editor, make the changes below to line# 31  

based on the Channel number in your specific handout  
 

17) (Only two of you will be on same channel)  
 

 
 
18)  In CCS: With the top-level of the project highlighted, do a Build All (Ctl+B), this may take a few 

minutes the first time you build. 
 

19) In CCS: using the circled menu icons select Debug then Run to re-program the flash  
 
 
 
 
 
 
 
 
 



Lab Procedures: Texas Instruments Low-Power Wireless Speedway Workshop 
 

 Page 14 of 20  
 

 
20) In CCS: Stop debugging and unplug Chronos from Emulator Board 

 
21) On Chronos: Press the UP button to wake-up the display  

 
22) Bottom Menu displays “C2C”  

 
23) Press “v” (lower-right button) to turn on RF transmission 

 
24) Press “#” (lower-left button) to increment your partner‟s Chronos counter 

 
25) If your Chronos counter changes then your partner is pressing his Chronos button 

 
26) Winner: Find your partner and then yell “Chronos!” 
 
 

 

Chronos2Chronos Interaction 
Summary
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Lab 2B: SmartRF Studio + Chronos 
 

 
 
In CCS: we changed the RF settings manually 

○ CHANNEL: simple, manageable 
○ Frequency, modulation, filtering: user‟s guide 

 

 
 
In Smart RF Studio: Change RF settings automatically 

○ Fully configure your system 
○ Instantly verify your settings with connected devices 
○ Template & code generation 

 
 
What is SmartRF Studio-7 ?  
Smart RF Studio is a Windows App that lets customers evaluate, test and configure Low Power RF 
devices from Texas Instruments. It is particularly useful for generating chip-specific register values and for 
finding and fine-tuning RF parameters. It may be used standalone or together with applicable Eval Boards
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Smart RF Studio 7: Configure Register View 
 

1) Open SmartRF 
○ Right click on CC430 and open  

in off-line mode 
 

2) Configure Register View 
○ Select View  Expert Mode  
○ Enable checkboxes 

▪ Register View 
▪ RF Parameters  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3) Align with the partner you just found on a new frequency 

 
4) Note: This must be within your assigned frequency range 

 
5) Change to your assigned RF base frequency  

 
6) Notice the changes in the register view  
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7) In CCS: Open file smartrf_cc430.h again 

 
8) Find the three #define lines for FREQ (Lines 25 – 27) 

 
9) Copy new Hex values from SmartRF to the appropriate lines 

 
10) Reset the previously edited SMARTRF_SETTING_CHANNR to 0x00 (Line 31)  
 

 
 
11) Recompile, download & run the project  

 
12) Stop debugging and unplug your Chronos 

 
13) Use the Chronos2Chronos menu again 

 
14) Help your partner 

 
15) Make sure you are using the frequency band assigned to you  

[check the handout sheet] 
 

16) Can you see similar results? [Yes] 
 

17) Are you still able to connect to your partner? [Yes] 
In the first section (Lab2A) we modified the channels. 
In the second section (Lab2B) we modified the base frequency and kept the channels to zero.  
In both cases you should see similar results and connect with your partner.  
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Lab 2C : Chronos RSSI Meter 
 
Objective: 
• Instructor broadcasts carrier freq. of 906 MHz (chan# 20) 
• Students measure RSSI on their Chronos units 
• RSSI value is observed for changes as distance between transmitter and receiver is increased (and 

obstructions/ interference introduced into the signal path)  
 
Add RSSI Power Meter to Menu 
1) In CCS4, close Lab2_Chronos2Chronos project  

 
2) Import the Lab2c_RSSI project and Open 

o Project > Import Existing CCS/CCE Eclipse Project 
o Select C:\TEMP\Lab2C_Chronos2Chronos project  

(ensure “Copy Projects into Workspace” checkbox is checked)  
o Click Finish to import…  

 
3) Right Click on project name > “Set as Active Project” 

 
4) Select „Active Build Config‟: 915MHz - Unrestricted CCS Platinum ( USA )  

 
5) Open logic\menu.c source file in the CCS editor… 
 

 
 
6) In menu.c:    

Verify line# 152: &menu_L1_Temperature is commented-out  
and    line# 154: &menu_L1_Powermeter, is uncommented to map “Powermeter” as the next  
menu-item pointer.  
 

7) Recompile, Download and Run … 
 

8) Instructor only! Top Menu: Press “*” (top-left button) to step through the menu, go an additional step 
past “rSSI” to “trAn” (for transmit) 
 

9) Instructor only! Top Menu: Press “^” (top-right button) to turn on the transmission  
 

10) Instructor only! Instructor‟s Chronos LCD displays:  
- “906” (Chan# 20, Tx Freq in MHz)  
- animated Beeper/Wireless icon 

 
Key to Top Menu:  
rSSI = for Received Signal Strength Indicator (in dBm) 
trAn = for transmit (this for instructor‟s Chronos only!) 
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11) Top Menu  Cycle to “rSSI” 

 
12) Press “^”    Turn on “rSSI” (to start RSSI measurements) 

 
13) Student‟s Chronos LCD displays: 

- received power level in dBm (eg. “-43”)  
- animated Beeper/Wireless icon 
 

14) Move Chronos units apart, experiment with 
metal shielding and other obstructions,  
(eg. if the transmitter turned ON/OFF 
your Rx RSSI reading will change from  
around -40 dBM to -100 dBm  
(when Chronos units 12 inches apart) 
 

15) What range of RSSI values do you see?  
 

16) Press “^” again on both units to Stop  
transmission and measurement 

 
17) Move closer/away from CC430EM to see differences in reading 

 
Comments:  
Instructor‟s CC430 is broadcasting  

○ Continuous RF carrier @ 906 MHz 
Student‟s Chronos measures power  

○ @ 906 MHz (with 400 kHz filter)  
The dBm reading changes with 

○ Distance 
○ Interference / obstacles 
○ Antenna radiation pattern / characteristic 

 
 
 

Labs: Part 2 Conclusions… 

 
Lab 2A:The Chronos2Chronos application was edited (for selection of specific RF channels within 
designated ISM band), then re-compiled and executed for peer to peer SimpliciTI communication  
 
Lab 2B: Provided a brief insight into use of SmartRF Studio 7 software tool to re-configure the CC430 RF 
settings 
 
Lab 2C: Implemented a simple RSSI power-meter application on Chronos. 
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Appendix: Re-flash of Chronos back to default “Sportswatch” application  
 
Instructor only! When transitioning from Lab2 to the Demos, the instructor will need to re-flash his 
Chronos back to the default “Sportswatch” application.  
(It is recommended that workshop attendees also be familiar with the 3

rd
 party tool for this).  

 
The easiest method to reprogram Chronos is using BM Innovation‟s Firmware Update Tool.  
(from the eZ430-Chronos Watch Firmware Update Tool.exe download) 
 
Again reprogramming the MCU‟s flash memory using the FET debugger/programmer dongle, this tool 
writes the wireless updater into BSL memory of the watch and programs the corresponding SportsWatch 
recovery firmware according to latest eZ430-Chronos release) 
The script to select is: 915MHz_Firmware_Update_1_5.bmt 
 

 

Figure 11 - BM Innovations Firmware Updater Tool re-programming Chronos 

 

Getting Help and Support 

 
TI Page  http://focus.ti.com/docs/toolsw/folders/print/ez430-chronos.html  
wiki:   http://processors.wiki.ti.com/index.php/EZ430-Chronos  
GoogleGroup:  http://groups.google.com/group/ti-chronos-development-/topics  
E2E:   http://e2e.ti.com  MSP430 Microcontroller Forum  
 
 

http://focus.ti.com/docs/toolsw/folders/print/ez430-chronos.html
http://focus.ti.com/docs/toolsw/folders/print/ez430-chronos.html
http://processors.wiki.ti.com/index.php/EZ430-Chronos
http://groups.google.com/group/ti-chronos-development-/topics
http://e2e.ti.com/
http://e2e.ti.com/support/microcontrollers/msp43016-bit_ultra-low_power_mcus/f/166.aspx

